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Introduction 

 

This tutorial aims at introducing the user to the SCIA Engineer functionalities which are used in the design 

of a commercial steel building structure.  The functionality in this tutorial are consistent with those found 

in the Fundamentals Edition of SCIA Engineer.  Additionally, in order to properly understand the tutorial, 

the user must be familiar with the basic principles of the Finite Element Method.  For more detailed 

information on the Finite Element Method and how it is utilized in SCIA Engineer, refer to the FEM 

Training Manual. 

 

In all, this tutorial consists of 7 parts including: 

 

Part 1 – Modeling 

Part 2 – Loading 

Part 3 – Analysis, Meshing & Results 

Part 4 – Steel Design (Columns, Braces, Joists) 

Part 5 – Composite Steel Design 

Part 6 – Concrete Shear Wall Design 

Part 7 – Engineering Report 

 

In Part 2 of the Commercial Steel Building tutorial, the functionality and features that are available to 

create load cases and combinations as well as add load to the structure will be discussed. 

 

http://downloads.scia.net/support/sciaengineer/manuals/15/fem/%5beng%5dtopic%20training%20-%20fem_15.1.106.pdf
http://downloads.scia.net/support/sciaengineer/manuals/15/fem/%5beng%5dtopic%20training%20-%20fem_15.1.106.pdf
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Create Load Groups & Load Cases 

Load Groups 

Before adding load cases to the project it is necessary to create load groups.  Load Groups are used 

to combine individual load cases when they are inserted into a load combination.  These are especially 

important when using the automatic load combinations based on the ASCE.  To access the 

functionality, double click on Load Groups from the Load Cases, Combinations service found in the 

Main service tree. 

 

 

 

 

With the load group manager open, the program creates a load group for permanent load (dead load) 

by default.  Change the name of LG1 to Dead and then click the New button to create additional load 

groups.  The following parameters for each load group can be modified: 

 Name: name of the specific load group 

 Relation: how the cases within a group will be combined. 

o Standard: Load case sorting and combination will be used when creating load 

combinations. 

o Exclusive: Load cases of the same load group are always inserted into a new combination. 

o Together: Two load cases from the same load group will never appear in the same 

combination. 

 Load: Permanent (dead loads) and variable (all other loads).  Accidental is not used for IBC code. 

 IBC – load types: As defined in ASCE 7 Section 2.2. 

 

 

It is now possible to create the following load groups: 
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 Live: Relation = Standard, Load = Variable, IBC – load type = L – Live Load 

 Lroof: Relation = Standard, Load = Variable, IBC – load type = Lr – Roof Live Load 

 Seismic: Relation = Exclusive, Load = Variable, IBC – load type = E – Earthquake Load 

 Wind: Relation = Exclusive, Load = Variable, IBC – load type = W – Wind Load 

 

With all the necessary load groups created, it is now possible to create individual load cases. 

Load Cases 

Now that the structure has been modelled properly and before an analysis can be executed, individual 

load cases need to be created in order to add various load types to the model.  To begin adding load 

cases double click on Load Cases from the Load Cases, Combinations service found in the Main 

Service tree. 

 

 

 

  

 

With the load case dialogue open, new load cases can be added to the existing self-weight load case 

(LC1) that is created by default in every project.  To add load cases, click New.  For each individual load 

case, the Name, Action type, Load Group and Load type need to be set.  For this example, all load 

cases (with the exception of the self-weight case) will be created with Action type Variable.  Additionally, 

when modifying the parameters of each load case, make sure that the name that is being set matches 

the correct Load Group.  It is now possible to create the following Load Cases: 

 Dself-CONST:  

o Action Type = Permanent 

o Load Group = Dead 

o Load Type = Self-Weight 

o Stage for Composite Analysis Model = Construction Stage 
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 Dself-FINAL:  

o Action Type = Permanent 

o Load Group = Dead 

o Load Type = Self-Weight 

o Stage for Composite Analysis Model = Final state, long term 

 Dsup 

o Action Type = Permanent 

o Load Group = Dead 

o Load Type = Standard 

o Stage for Composite Analysis Model = Final state, long term 

 L 

o Action Type = Variable 

o Load Group = Live 

o Load Type = Static 

o Stage for Composite Analysis Model = Final state, short term 

 Lroof 

o Action Type = Variable 

o Load Group = Lroof 

o Load Type = Static 

o Stage for Composite Analysis Model = Final state, short term 

 Ex 

o Action Type = Variable 

o Load Group = Seismic 

o Load Type = Static 

o Stage for Composite Analysis Model = Final state, short term 

 Ey 

o Action Type = Variable 

o Load Group = Seismic 

o Load Type = Static 

o Stage for Composite Analysis Model = Final state, short term 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Note: Wind load cases will be created automatically by way of the 3D wind load generator. 
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Gravity Loads 

 

With load cases and groups created, it is now possible to add the required gravity loads to the structure.  

To do this, double click on             to open the Load service.  When the Load service opens different 

types of loading can be applied to the created load cases by selecting them from the drop down box.   

 

 
 

To begin this process, select Dsup from the drop down menu and then click the [+] to expand the surface 

load functionality.  Next, double click on                           to open the surface force dialogue.  When the 

dialogue opens, configure the properties of the surface force as shown in the picture below and click OK.   

 

 
 

The command line now instructs the user to select the specific 2D members in which the load should 

be applied.  Select all 5 plate elements (4 composite floors and 1 metal deck roof) to apply the load.  After 

the selection is complete, right click and select OK or press ESC to end the command. 
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Additional gravity loads will be added in a similar fashion.  Apply the following surface loads on 2D 

members as follows: 

 

Live Load (L) @ FL1 to FL4:  

 Value = -40 PSF, Direction = Z 

 

Roof Live Load (Lroof) @ FL5:  

 Value = -25 PSF, Direction = Z 

 

Note: Other load types (ie. point loads, line loads, etc.) can be added through the load service as well.  

Additionally, the easiest way to review all applied loads and make quick modifications is using the 

Table Input.  The table input is available by navigating to View > Toolbars and selecting table input.  

Within the table input, various structural elements, library items and applied loads can be viewed 

and manipulated.  Additionally, items selected within the table will also be selected in the graphical 

interface. 
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Lateral Loads 

3D Wind Loading 

With the gravity loads applied to the structure, it is possible to add wind loading to the structure using 

the 3D wind load generator.  Before loads can be added the functionality needs to be enabled from the 

Project menu.  To do this, double click on Project in the Main Service tree and navigate to the 

Functionality tab.  Click to enable Climatic loads and then switch to the Loads tab. 

 

Within the Loads tab, change the combo box under Wind Load to according to code and click on the 

ellipsis button to access the code setup. 

 

 
 

The various properties within the wind setup can then be modified to match what is shown in the below 

picture.  Within SCIA Engineer, it is possible to utilize the wind provisions from ASCE 7-05 and 7-10 

while also choosing between the low-rise method (envelope procedure) or all heights method 

(directional procedure). 

 

 
 

Once the properties are set, click OK and then set the Snow Load to Snow Weight.  This is required in 

order to properly utilize the 3D wind loading within the project. 
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With the properties of the load set, the surfaces (plates & load panels) that will have the 3D wind load 

applied to it need to be specified.  This is done by selecting a surface and clicking to enable the 3D 

wind in the properties of the panel or surface.  For this example, select each of the load panels (13 in 

total) and enable the 3D wind checkbox in the member properties.   

 
 

Additionally, it is a requirement of the 3D wind load engine that the outer surface of the element be 

properly defined based on the direction of the wind data arrow.  This is done so that the wind 

generator can properly assign the internal and external pressure coefficients to the structure. 
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In this example, the swap outer surface checkbox needs to be enabled for 6 of the load panels (where 

the wind direction arrow on the panel is pointing inward).  In addition to enabling 3D wind on the load 

panels, it should also be enabled on the exterior shear wall and the roof plate in order to ensure that the 

entire exterior of the structure is enabled for 3D wind load application. 

 

 
 

With the 3D wind load enabled on all exterior surfaces, the wind load cases can be generated from the 

Load service by double clicking on                                .  In the first dialogue, the mean roof height 

should be set to 60’-0”.  Next, click the Add load cases button.  The subsequent dialogue will list the 

active wind directions and combinations of internal (Cpi) and external (Cpe) pressure coefficients.  

Additional wind directions can be added by right clicking to insert a new line.  Click OK to create the 

load cases and then click Run generator to create the load cases. 

 

 
 

Once the wind generator has been successfully run, it is possible to evaluate individual wind load cases 

in order to assess that the proper coefficients were applied in accordance with the ASCE 7 code. 
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Note: To enable the labels of wind data (and pressure coefficient), right click in the workspace and 

select Set View Parameters for All.  Then make sure that wind data and labels of wind data are 

enabled within the Loads/Masses tab.  
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Seismic Loading (Equivalent Lateral Force Procedure) 

In addition to adding wind loading to the structure, seismic loading can be added by way of creating 

response spectrums and using them as seismic load cases.  Before seismic loads can be added, it is 

necessary to make sure that the Dynamic and Seismic functionality is enabled.  To do this, double 

click on Project in the Main Service tree and navigate to the Functionality tab.  Click to enable 

Dynamics and Seismic. 

 

With all necessary functionality enabled, the seismic response spectrum can be defined by navigating 

to Libraries > Loads > Seismic Spectrums.  When the dialogue opens, close the predefined 

database in order to access the seismic spectrum input dialogue.  Then change the input type to 

IBC and click code parameters to set the ASCE code provisions of the spectrum.  In this example, the 

values for the spectrum can be defined as shown below: 

 

 
 

Once the spectrum is defined, masses need to be added to the structure in order to properly execute 

the seismic analysis.  In SCIA Engineer, masses can be added in two different ways: 

1. By adding them manually using                  found in the Dynamics tree.  Masses can be added 

at nodes, beams or surfaces. 

2. Automatically from previously created linear loading via                        .  

 

For this example, the masses will be created automatically, first double click on mass groups and 

enter the following mass groups.   

 

Dead: 

- Bound to load case: Yes 
- Load case: Dsup 

 
Live: 

- Bound to load case: Yes 
- Load case: L 

 
Lroof: 

- Bound to load case: Yes 
- Load Case: Lroof 

 
After adding each mass group, press the action button create masses from load case to generate the 

masses that are associated with the already applied linear loading. 
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After mass groups are created, it is required that they be combined into a                                            .  

Double click on the functionality and add the three available mass groups (Dead, Live & Lroof) to the 

contents of the combination and rename the combination D+0.3L.  Click OK to finish the input and then 

change the load factor of mass groups Live and Lroof to be 0.3. 

 

Note: Self-weight of the structure is always taken into account as mass and does not need to be added 

as a specific mass group or into the combination of mass groups. 

 

With the seismic spectrum and mass combination created, specific seismic load cases can be 

defined.  To do this, double click on                       and select the previously created Ex load case.  Input 

the parameters of the seismic load cases as shown below.  Similar parameters can be used for the Ey 

load case as well, with the only change required is enabling the seismic spectrum in the Direction Y. 

 

 
 

Notes: 

- When setting the appropriate load type, first select Dynamic with specification Seismicity.  

Then enable the Equivalent Lateral Forces.  This will automatically change the load type to 

static equivalent. 

- The acceleration factor is the used to reduce the effects of the seismic spectrum.  In this way, 

the value is equal to 1/R. 

- The inputted fundamental period is based on the equation 𝑇𝑎 = 𝐶𝑡ℎ𝑛
𝑥
 

- Enabling the accidental eccentricity requires the user to set the percentage of load associated 

with eccentricity.  When eccentricity is enabled an addition accidental eccentricity load case is 

created.  This load case will be automatically combined with the seismic load case so that the 

user can review all seismic load effects in a chosen direction. 
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Load Combinations & Classes 

Load Combinations 

With all gravity and lateral load cases created and applied to the structure load combinations should 

be created in order to properly combine the loading for analysis and design purposes.  To access the 

load combinations double click on                          .  When the dialogue opens, you will initially see two 

previously created combinations (for seismic load + seismic eccentricity).  To create new combinations, 

click New.  Within SCIA Engineer, it is possible to create various types of load combinations including 

envelope, linear and code based envelopes.  For this example, we will create two IBC code based 

envelopes for strength and service level design conditions.  With the load combination dialogue open, 

the ULS and SLS combinations can be created as shown below (with all load cases added to each 

combination). 

 

 
 

In addition to the envelope combinations, create two linear combinations for the evaluation of specific 

load combination.  For this example, create the following: 

 

1.2D+1.6L+0.5Lr 

- Type: linear ultimate 

- Load cases: Dself-Final, Dsup, L & Lroof 

- Combination Factors: 1.2 on all dead load, 1.6 on live load & 0.5 on roof live load 

 

0.9D+Ex 

- Type: envelope ultimate 

- Load cases: Dself-Final, Dsup & Ex 

- Combination Factors: 0.9 on all dead loads 
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Notes:  

- The IBC envelope is created using ASCE 7-10 combinations.  If you want to use the 

combinations from ASCE 7-05, navigate to Project > Code Setup and change the code for 

combinations. 

- Code based combination envelopes and other envelopes can be exploded in order to review the 

individual combinations that make up the envelope.  To do this, select one of the envelope 

combinations and select the Action button Explode to linear. 

 

Results Classes 

With the load combinations created, it is also possible to create a result class.  Result classes are 

used to group cases and combinations together for a more in-depth comparison.  A good example of 

this are the sixteen different wind load cases that were created by the 3D wind load generator earlier in 

the example.  In order to properly evaluate the wind on the structure and to easily determine which wind 

load cases are controlling, all wind load cases should be added into a new class.  To do this, double 

click on                          from within the Load cases, combinations service and click New.  Add all 3D 

wind load cases into the contents of the class and name the class All Wind.   

 

With all loads, load cases, combinations and classes created the model is ready for mesh/solver setup 

and analysis.  At this point in the tutorial it is wise to save the model (File > Save) and then proceed to 

Part 3 – Analysis, Meshing & Results of the tutorial by visiting the Manuals and Tutorials section of 

the website to download the PDF. 

 

 

https://www.scia.net/en/support/downloads/scia-engineer-manuals-tutorials

